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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,



cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when Ardbox family PLCs.

In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contrdleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Ardbox sont des controleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
controdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Ardbox.

En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmospheére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: - Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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Supply Yoltage

24 \cc

I/Os

Ardbox Relay HF: General Features

COMPACT PLC ARDUINO ARDBOX 201/0Os
RELAY HF PLUS

Fuse protection (2.5A)

Analog Output 8bit
(0-10Vcce)

Input Voltage 12 to 24vdc Polarity protection
Input rated voltage 24 Vde
Rated Power 30w
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB
. . 12C -- USB -- RS232 -- RS485 --
Communications SPI - TTL RS485
TOTAL Input points 10
TOTAL Output points 10
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 5 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input S B 5 to 24Vdc
I min: 2to 12 mA I min: 3/6 mA
HS Galvanic Isolation Se arated PCB ground
(24Vcc) Rated Voltage: 24Vdc P 9
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

220V Vdc
Galvanic Isolation

PWM lIsolated Output
8hit (24vce)

D|g|ta| Isolated Output Diode protected for Relay Imax: 5A
Relay -
5 to 24Vdc
I max: 70 mA
Galvanic Isolation PWM lIsolated

Diode Protected for Relay
Rated Voltage: 24Vdc

Output 8bit (24vcc)

Expandability

12C — RS232 — RS485 - SPI - TTL

11
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2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply

12 to 24Vdc ==

Operating

voltage range DC power supply

11.41t025.4Vdc ===

Power
consumption DC power supply 30VAC max.
External Power supply voltage | 24Vdc ===
power supply
Power supply output 700 mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.

2.2 Performance Specification:

Arduino Board ARDUINO LEONARDO

Control method Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutoria/lHomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM)

2.5KB

EEPROM

1KB

13
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Clock Speed

16MHz

2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the Ardbox Relay HF+:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : : .
] Graphical symbols 5031 / Direct Inohcates that_ the equipment |§
EE = =m suitable for direct current only;
for use on Current . : ;
, to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
TN for use on 5032 C/:Alternatmg only; to identify relevant
: urrent :
equipment terminals
IEC 60417 /
Graphical symbols To identify the control by
for use on 5130/Pulse which a pulse is started.
, General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
: Ground : - )
equipment 5019 is explicily required.
IEC 60417 / : . .
o ety e st
for use on 5115/ Slgnal lamp : ) 9
) lamp(s) is (are) switched on or
equipment off

q

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC PP P
regulations
ISO 7000/ . .
Graphical symbols Indlcates'a pqtentlal'ly .
f 0434B / hazardous situation which, if
or use on : ) .
equibment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Gra;;hlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
) Voltage from dangerous voltages
equipment

14




3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Relay HF PLUS and follow its
descriptions for reference during operation.

3.1  Arduino Board

The ARDBOX 20 I/Os Relay HF PLUS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 1/Os Relay HF PLUS under different conditions from what has been
specified in this manual or integrating ARDBOX 20 |/Os Relay HF PLUS to nuclear control
systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

15



4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network:

Sketchbool: location:

C:\Users\Albert\DocumentsiArduing Browse
Editor language: English (English) ~ | (reguires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 %  (requires restart of Arduing)

Show verbose output during: compilation upload
Compiler warnings: None

[Jpisplay line numbers

[JEnable Code Folding

Verify code after upload

[Juse external editor

Check: for updates on startup

Update sketch files to new extension on save (.pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs: http:/,’appa‘\ndustrla\ah|e\da.mm,fmaln/ardulnn,t‘huardafpa(\'agef\ndustr\alahle\daflnde ﬁ

More preferences can be edited directly in the file
C:\Users\Albert\AppData\Local\Arduino15\preferences. tet
(edit only when Arduina is not running)

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

16
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5. Search for industrialshields.

& Boards Manager s
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

P Install

Close

6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

un2ga | Arduin

File Edit Sketch Tocls Help

Aute Farmat Gk T
Aschive Sketch
skatch_jun293 Fix Encoding & Reload

up () Marage Librares... Ctrls Shifte] L)
HE YRS serial Monitar Ctri+Shifte M
) Serial Platter Cirle Shifte L

W01 / WIFININA Firenwrare Updater

Beard: “Ardbox family” i Boards Manager..
3 Model: “Ardbex Analog™ 3 Arduing AVR Bosrds L
Port ' R T Boaeds
Get Bosrd Info @mmm 381 Adbos famiy >
Programmer : — :

Ardbex GPRS family
Ardben WiFi/BT family
Ardbex Lofa family
M-Duing family
M-Duing DALI farmily
M-Dusing GPRS family
M-Dusino LoRa famidy
M-Duing WiFVBT family

Buen Bocticader

Spartan family



Once the Ardbox Family is selected, an extra option will appear on Tools:

- Select the correct Ardbox Relay HF PLUS Board (Ardbox Relay HF+ w/HW RS-232 or
Ardbox Relay HF+ w/HW RS-485) depending on your jumpers & switch configuration.

i o
Auto Format QT
Archive Sketch
skelth_jusdda Fix Encoding S Reload

4 ap ) Minage Libvaries... Cirde Shifte|
s e Serial Moniter Ctrle Shifte M
Serial Phatter CrbeShiftL

WFI01 / WIFININA Firrrvware Updater

Board: *Ardben Family” >
Modek: “Ardbex Anslog” 18 ardbor Anslog

Pest Ardbox Analog HF wi HW RS-232
Get Boaed Info Ardbox Analog HF w HW RS-425
P— Ardbax Analag HF+ w/ HW RS-232

Ardbax Anslog HF-+ w/ HIV RS-455
Ardbox Analog HF (legacy)
Ardbox Relay

Ardbox Relay HF w/ HW RS-232
Ardbon Relay HF vl HIW RS-485

Bum Bocticader

Rsdloox Basic Controller

Also there are some examples of programming in File -> Examples -> Ardbox Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

18
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5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox Family
- Select correct port.

@ sketch_mar16a | Arduino 180 - o x
File Edit Sketch Tools Help
Auto Format colsT
Archive Sketch
£ FixEncoding & Reload
Serial Monitor ColaShifeaM
Serial Plotter ColsShitesd

WIF101 Firmware Updater

Boardt “Ardbas family
Inchustrial Shields: “Ardbox Analag”

Port i Senaipors
Y GetBamdinto COM13 (Arching Leonarddo)

, Programmer:Archin as ISP
Bum Baotioarer
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6. How to connect PLC to power supply

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vvdc.

e Hoo |

r—f 24voe |

| I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm ‘
DIN Rail: m |

-12vdc / 24Vdc T
-2.5A
-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

TRBY

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

20



7. Ardbox Relay I/0 pinout:

7.1 Zone Connections

= c
=] o
58 | 2 S
Qo E 5 o
o ° 5
<O < I
MISO 14 SPI-MISO
MOSI 16 SPI-MOSI
SCK 15 SPI-CLOCK
RESET - SPI-RESET
5vdC - 5V Output
GND - GND
RX-RS-23212 8 Serial/RS232
TX-RS-23212 4 Serial/lRS232
SCL-PIN2? 2 12C/SPI SS
SDA-PIN3! 3 12C/SPI SS
R1 10 Relay 1 Out
R2 9 Relay 2 Out
R3 6 Relay 3 Out
GND - GND
24V - -

SN OFF
NC

HD-FDx
RS/PIN3-SCL
10.0/PIN2-SDA

RE-RS485/104
10.4/RE-RS485
DE-RS485/10.5
1.05/DE-RS485
TN

MISO
MOSI
SCK
RESET
SVdc

v XTI THY W X
=
CAPSY

EN

=
=
'
)
=
>
$§-221

IARZ-21
43mM0d

HS*: Hardware Serial
SS*: Software Serial

1 See section 8 to enable these connections

2 See section 9 to enable these connections

LEFT ZONE

Switch config*

(see section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Communications pins

Relay Outputs

Power supply connectors
(24vdc - GND)
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x RIGHT ZONE
= £0
i) o T -
[8]

s | 28 2

o £ =R [3)

o | B9 5

< O < [} H

B- - RS485 [

A+ - RS485 RS-485 pins
Z-IA0.1 - RS485/Digital Output Wa Analog Outputs Pins
Y+/A0.0 - RS485/Digital Output 'J

R4 5 Relay 4 Out x Relav O

R5 3 Relay 5 Out RS Al elay Outputs

10.9 23 Analog/Digital Input {

@ g
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8. Switch configuration

8.1 General Switches Configurations

LEFT ZONE SWITCH

Communications and inputs/outputs cannot work simultaneously.

LEFT ZONE
ON OFF
SWITCH ON OFF
NC
NC - - HD - FD*
HD/FD* Half Duplex Full Duplex R5/PIN3-SCL
R5/Pin3-SDA R5 PIN3 - SDA 10.0/PINZ-SDA
10.0/Pin2-SCL 10.0 PIN2 - SCL RE RS48510 4
RE-RS485/10.4 RE-RS485 0.4 10.4/RE-RS485
10.4/RE-RS485 10.4 RE-RS485 DISREFEEDE
10.5/DE-RS485
DE-RS485/10.5 DE-RS485 10.5 - —
10.5/DE-RS485 10.5 DE-RS485

1. NC- Not Connected

2. HD/FD* — Choosing between Half/Full Duplex for the RS485 communication. In order
to use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE(*see
section 9).

3. R5/ Pin3-SCL — If this switch is ON the R5 is activated, otherwise the Pin3 - SDA will be
activated.

4. 10.0 / Pin2-SDA — If this switch is ON the 10.0 is activated, otherwise the Pin2 - SCL will
be activated.

5. RE-RS485 /10.4 — If this switch is ON the RE-RS485 is activated, otherwise the 10.4 will
be activated.

6. 10.4 / RE-RS485 — If this switch is ON the 10.4 is activated, otherwise the RE-RS485 will
be activated.

Note* To work with RS-485 RE, switch number 5 at ON and number 6 at OFF.

7. DE-RS485 / 10.5 — If this switch is ON the DE-RS485 is activated, otherwise the 10.5 will
be activated.

8. 10.5 / DE-RS485- If this switch is ON the 10.5 is activated, otherwise the DE-RS485 will

be activated.

Note* To work with RS-485 DE, switch number 7 at ON and number 8 at OFF.
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TOP ZONE SWITCH

ON

OFF

TOP ZONE
SWITCH ON OFF
RS*/ R8 RS* R8
R8/ RS* R8 RS*
RS* / R7 RS* R7
R7 /RS* R7 RS*

RS*
R8
RS*
R7*

Communications and outputs cannot work simultaneously.

4. RS* / R8 - If this switch is ON the RS* is activated, otherwise the R8 will be activated.
3. R8 / RS* - If this switch is ON the R8 is activated, otherwise the RS* will be activated.
2. RS* / R7 - If this switch is ON the RS* is activated, otherwise the R7 will be activated.
1. R7 / RS* - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have chosen.

To work with RS*, switches number 1 and 3 at ON and number 2 and 4 at OFF.

8.2 RS- 485 Switch configuration

RS-485 TOP ZONE: In order to enable the RS-485 protocol the
TOP ZONE must be configured as it is shown in the table.

Having this setup, the R7 & R8 are disabled.

table.

TOP ZONE
SWITCH MODE
RS*/ RS ON
R8/ RS* OFF
RS* /R7 ON
R7 /RS* OFF
LEFT ZONE
SWITCH MODE
NC -
HD/FD* ON/OFF
R5/Pin3-SDA -
10.0/Pin2-SCL -
RE-RS485/10.4 ON
10.4/RE-RS485 OFF
DE-RS485/10.5 ON
10.5/DE-RS485 OFF

RS-485 communication protocol.

RS-485 LEFT ZONE: In order to enable the RS-485
communication protocol it is necessary that the switches
of the left zone are configured as it is showed in the

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section

The ones marked with “-“ mean that they don’t affect the
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8.3  RS-232 Switch configuration

RS-232 TOP ZONE: In order to enable the RS-232
communication protocol it is necessary that the switches of
the top zone are configured as it is shown in the table.

RS-232 LEFT ZONE: In order to enable the RS-232

communication protocol it is necessary that the switches

of the left zone is configured as it is showed in the table.

None of them affects to the RS-232 communication but if

you are using it you can use also use the inputs 10.4 and

10.5.

The ones marked with “-“ mean that it does not affect

the RS-232 communication protocol

TOP ZONE
SWITCH MODE
RS*/ 10.2 OFF
10.2/ RS* ON
RS*/10.3 OFF
10.3 /RS* ON
LEFT ZONE
SWITCH MODE
NC -
HD/FD* ON/OFF
R5/Pin3-SDA -
10.0/Pin2-SCL -
10.4/RE-RS485 ON
RE-RS485/10.4 OFF
10.5/DE-RS485 ON
DE-RS485/10.5 OFF

* To enable the RS-232 communication it is needed to configure also the jumpers, see Section

8.4  12C Switch configuration

TOP ZONE
SWITCH MODE
RS* / 10.2
0.2/ RS*
RS*/10.3
10.3 /RS*

LEFT ZONE
SWITCH MODE
NC -
HD/FD* -
R5/Pin3-SDA OFF
10.0/Pin2-SCL OFF

10.4/RE-RS485 -
RE-RS485/10.4 -
10.5/DE-RS485 -
DE-RS485/10.5 -

To enable 12C configuration the switches SDA/R5 & SCL/10.0 must be set to ON. As they are in

ON mode R5 & 10.0 are disabled.

The switches marked as “ —“ don’t interfere with the 12C communication protocol.
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9. Jumper configuration

9.1

JUMPER ZONE 1

LEFT RIGHT
Y+ Z-
ENABLE ENABLE
A0.0 A0.1
JUMPER ZONE 2
LEFT RIGHT
10.2 10.3
D4 D8
RS-232 RS-232
JUMPER ZONE 3
upP RS-485 | D1 | RS-232
DOWN | RS-485 | DO | RS-232

General jumper configuration

This jumper zone makes the selection between using the RS-485 Full
Duplex or the Analog Outputs. If it is wanted to use the RS-485 Full
Duplex communication protocol the Y+ must be connected to ENABLE,
and Z- also connected to ENABLE. If it is wanted to use the Analog
Outputs, The A0.0 must be connected to ENABLE, and AO0.1 also
connected to Enable.

This jumper zone makes the choosing between connecting the inputs
10.2, 10.3 to pins 4 and 8 of the Arduino Leonardo respectively, or
connect the RS-232 ports to activate the Software Serial RS-232. In
order to use the inputs 10.2,10.3 the jumper must be connected to the
pins 4 and 8. So 10.2 must be connected with D4 and 10.3 must be
connected to D8.

This jumper makes the choosing between connecting MAX232 to pins
0,1 of the Arduino Leonardo or with the MAX485. In order to use the
RS-232 Hardware Serial protocol both RS-232 must be connected to
the D1/DO. In order to use the RS-485 Hardware Serial protocol both
RS-485 must be connected to the D1/DO.

*The jumpers that are not connected to the middle jumpers MUST NOT be connected anywhere.

OQutputs
AO.0
AD.1

RS-232

o 9
HARDWARE
QO® i

RS-485
HARDWARE
SERIAL

Digital
Inputs
10.2
I10.3

L X
RS-232

SOFTWARE
SERIAL
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10. Hardware Serial RS-232 & RS-485 Configuration

10.1 Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF
PLUS will be:

Switch configuration:

TOP ZONE

LEFT ZONE

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

o0
t: [ X JETern
(N

HARDWARE
o9 @®
Analog Digital
Dutputs Inputs
Ag. 8 18.2
48,1 18,3

Available communication protocols:

e Hardware Serial RS-485
e |2C *If 12C is active R5 & 10.0 are disabled

e SPI
e TTL
e USB
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10.2 Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF
will be:

Switch configuration:

TOP ZONE

LEFT ZONE

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

L X
:t ‘t O® :::

00 0O i

Analog il

Outputs Digital
A .8 Inputs
AR 1 I8.2

o Available communication protocols:
e Hardware Serial RS-232.
o |2C *If 12C is activated R5 & 10.0 are disabled
e SPI|
o TTL
e USB



11. Ardbox - Arduino 1/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL-Pin 3 3
SDA —Pin 2 2
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

11.1 I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

11.2 Pin 2/Pin 3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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12. I/0 technical details

Digital Output Waveform

[EREEE TR [ s —
v

DIGITALOUT

DIGITAL OUT
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PWM Waveform

PFWM OUTPOLUT
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ARDUIND PWHM OUT
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v

ANALDG OUT
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Analog/Digital Input Turn-on
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Ref.IS.AB20AN.HF+

13. Typical Connections

Ferrite KIT,

e,

0

SHIELDED CABLE E%

SHIELDED CABLE

Ssnarav
GND

O-10V

£,

n

Y

c @

SHIELDED CABLE J Douatoad D0 MOUNO LAYOUT: \

errite KITA

.7

Rev.3: 06-02-2023
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Ref.IS.AB20AN.HF+ Rev.3: 06-02-2023

o-10v

S LW Y

Ferrite KITA
'

A )~
7 B oceTasmacew

SHIELDED CABLE ) s e Foreg \

SHIELDED CABLE

sn2av

GND
ALWAYS
CONNECTED

Ferrite KI

),
SHIELDEDCABLE{ e — \
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Ref.IS.AB20AN.HF+

SHIELDED CABLE

Ferrite KIT#

Rev.3: 06-02-2023

2124V

SHIELDED CABLE

* Seo the switch
configutarion (ON)
e &
ALWAYS
n CONNECTED
Ferrte KITA @
GND -
‘E] I‘ VOUT =0/ Vde
SHIELDED CABL \
\/ J

SHIELDED CABLE
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Ref.IS.AB20AN.HF+

Ferrite KI°

TA

Rev.3: 06-02-2023

* See the switch
configutarion (OFF)

{n) v o-1ov)

\Z
SHIELDED CABLE
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14. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

15. ARDBOX Family Dimensions:

45mm width

&

114

- DIN rail mounting:

Profilato o cappello TH 35-7,5 Prcfilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
"
ak 1004
15°
. ROS
R12
e =03 R0
S
+
ISR 1004
A Sezione A/ Secton A k12
0.3 max - 2,2 min. finoa / To 2,5 max
3 -
< Sezone A/ Sedtion A
CARATTERISTICHE METODO  UNITA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Meccaniche li KT 0638  MPo 8 Mechanicol fest R ik ASTMDG638 MRy 8
Resi ongo s ASTIADE3B WP 8 Tnslestongth ASTHD63 MRy 8
Alrgamerto o totn KTM0638 % 59 Ut o ASTMDE38 % ]
Moduly in fesione KSTHDT0  MPo 2694 Pleing moduls ASTMDT0 MR yiiild
Provg lz0d con intoglo 15018014 Xy/ot 55 rod st otched 19018014 Xyin’ 55
Termiche Temp. di nmmollimento Vicot mekodo B ASTM 01525 °C 114 Thermal fest e metiodB  ASTMDIS2S °C 14
Tomperotum Riatio 1 81 MRy KTHDG8  °C 7 Rebeating temperctur 1,81 MPg ASTMDS4  °C 9
Fisiche Peso specio KA géamd 1 Physical test  Spacic gmuity ASTADTR2 _ géond 12
Riti nellostompo KTHD9SS % 0406 g shi ASTID9SS % 0406
Mk Flow Index 260°C- 98K KTADIZE g1l 11 ek Fiow index 260°C- 98K ASTHDIZE g1’ 1l
(Comportamento Aukesinguerzs (mm di pesor) o4 - V-0(08) Flame fest Saf atinguisher thideness in ) o4 - V-0(08)
ollo fiomma il Incondescen 32 mm 9521 °C 960 32 mm 169521 °C 960
Inaltronic si riserva il diiflo di modificore il moteriole con cui realizza i propri prodotti Itolonic con opercte any change of the moteriols without being obliged to forewam.
senzo obbligo di preawiiso.
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16.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/0O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 I/Os Relay HF PLUS 1/Os PLUS from heat, high voltaje and
eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 1/0s Relay HF PLUS. When configuring the layout of the ARDBOX 20 I/Os Relay
HF PLUS inside your panel, consider the heat-generating devices and locate the electronic-
type devices in the cooler areas of your cabinet. Reducing the exposure to a high-
temperature environment will extend the operating life of any electronic device. Consider
also the routing of the wiring for the devices in the electric cabinet. Avoid placing low-
voltage signal wires and communications cables in the same tray with AC power wiring and
highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 |/Os Relay HF PLUS. Is designed
for natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debrisin a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.

41



Ref.IS.AB20AN.HF+ Rev.3: 06-02-2023

17. Revision Table

Revision Number Date Changes
1 30/08/2019 First implementation
2 10/07 /2020 Second implementation
3 06/02/2023 Third implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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